
Vorwort
Einführung in den Anycubic Slicer Next (Orca-Version)

Was ist ein Slicer?
Setup und erster Drucktest

Optionen

Option Embossed Text
Option Add (Strg+I)
Option Add plate
Option Auto Orient

Glossar
Standardvorlage: Anycubic Slicer Next Seite
Reiter "Supports"
User Preset

Anycubic Slicer Next
(Orca Based)



Ich schreibe dieses Book nicht aus der Perspektive eines Profis, sondern als jemand, der gerade
selbst die Software lernt. Auch wenn ich technisch sehr versiert bin, bin ich im Bereich 3D-Druck
noch ein Neuling – und genau deshalb weiß ich, wie herausfordernd der Einstieg sein kann.

Viele Anleitungen sind auf Englisch und vollgestopft mit Begriffen wie Slicing, Brim, Skirt oder
Nozzle. Für jemanden mit weniger technischem Hintergrund ist das oft abschreckend. Ich habe das
Glück, dass ich Sysadmin bin und ich keinerlei Probleme mit komplexer Software oder komplexen
englischen Anleitungen habe – aber auch ich muss mich Schritt für Schritt durcharbeiten.

Und genau deshalb mache ich dieses Book: Weil ich sowieso alles gründlich durchgehe, kann ich
auch gleich mit dokumentieren – und warum nicht auch teilen? Vielleicht hilft es anderen.

Übrigens findet sich am Ende ein Glossar mit dem ganzen technischen Kauderwelsch ;).
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Einführung in den Anycubic
Slicer Next (Orca-Version)



Einführung in den Anycubic Slicer Next (Orca-Version)

Ein Slicer ist eine Software, die ein 3D-Modell (z. B. eine STL-Datei) in dünne horizontale Layer
zerlegt – daher der Name. Aus diesen Schichten erzeugt die Software G-Code, den ein 3D-Drucker
versteht.

Der G-Code enthält exakte Anweisungen für:

Bewegungen des Druckkopfs
Temperatursteuerung von Nozzle und Heatbed
Materialfluss (Flow)
Speed, Retraction, Cooling und mehr

Ein guter Slicer hat entscheidenden Einfluss auf die Druckqualität, Geschwindigkeit und Stabilität
des Modells.

Die Software übernimmt diese Aufgabe mit einer modernen Benutzeroberfläche und vielen
Automatisierungen. Nach dem Import eines 3D-Modells:

Wählst du die Druckeinstellungen (z. B. Material, Layer-Height, Speed)
Optional fügst du Stützstrukturen wie Brim, Skirt oder Raft hinzu
Die Software berechnet eine optimierte Druckvorschau
Du speicherst den G-Code auf SD-Karte, USB oder sendest ihn direkt an den Drucker

Dank der OrcaSlicer-Basis sind auch komplexe Funktionen wie Tree Supports, Druckzeitsimulation,
Input Shaping und Materialprofile enthalten.

Die Software wurde entwickelt, um das Zusammenspiel zwischen Hardware und Slicing-Logik zu
optimieren – besonders im Hinblick auf:

Dynamische Flow-Steuerung und Input Shaping
Unterstützung mehrerer Materialien und Farbwechsel
Integration mit AMS-Systemen (Automatic Material System)
Automatisierte Vorschau- und Bed Leveling-Funktionen

Was ist ein Slicer?

Wie funktioniert die Software?



Intuitive Benutzeroberfläche mit Profilverwaltung
Druckvorschau mit Simulation
Tree Supports, Grid- und Organic Support-Modi
Flow Dynamics & Shaper Tools für glattere Ergebnisse
Unterstützung für Acceleration und Jerk-Werte
Übernahme bewährter OrcaSlicer-Funktionen
Direktanbindung an Anycubic-Hardware (z. B. Kobra 3 Combo)

�� Einsteiger:innen, die eine einfache Benutzeroberfläche suchen
�� Fortgeschrittene, die G-Code und Parameter selbst optimieren möchten
��️ Power-User, die Hardware wie ACE, AMS oder spezielle Cooling-Profile nutzen

Hauptfunktionen auf einen Blick

Für wen ist die Software geeignet?



Einführung in den Anycubic Slicer Next (Orca-Version)

Du kannst die Software direkt von Anycubic herunterladen:
�� Windows
�� macOS

Doppelklick auf die heruntergeladene Datei
Den Installationsanweisungen folgen
Nach Abschluss kann der Slicer direkt gestartet werden

Du wirst gebeten, dich mit einem Account einzuloggen.
Das ist der gleiche Account wie auf makeronline.com. Falls du noch keinen Account hast,
kannst du ihn hier erstellen.
�� Dort findest du auch viele direkt druckbare Modelle!

Setup und erster Drucktest
 Die detaillierte Anleitung zum Setup (EN):
�� Anycubic Quick Start Guide

1. Anycubic Slicer Next herunterladen

2. Installation

3. Login

Infos zu weiteren Webseiten mit 3D-Modellen findest du im Kapitel 3D-Modelle

4. Vorschau, Slice und erster Druck

https://makeronline.com
https://wiki.anycubic.com/en/software-and-app/new-page-anycubic-slicer-beta(orca-version)/anycubic-slicer-next-slicing-software-quick-start-guide


Bevor du mit individuellen Einstellungen spielst, solltest du einen ersten Testdruck machen. Dieser
hilft dabei, zu prüfen, ob dein Drucker korrekt eingerichtet ist und auch korrekt funktioniert – ganz
ohne Änderungen an Profilen oder Parametern.

�� Am besten verwendest du dafür eine einfache .stl-Datei (z. B. 3DBenchy).
Vermeide .3mf-Dateien beim ersten Druck, da sie möglicherweise schon benutzerdefinierte Slicing-
Parameter enthalten.

��️ Wenn dein Drucker korrekt eingerichtet ist, sollte er dieses Modell out of the box sauber
drucken.

1. 3D-Modell importieren
Nutze oben Links File > Import, um dein Model zu laden (z. B. 3DBenchy.stl )

�� Falls du einen ACE nutzt:
Gehe im Bereich Process auf den Reiter Objects. Dort kannst du eine Farbe wählen.

1. Auf Preview klicken
Preview startet automatisch die Option Slice Plate. Du bekommst eine Vorschau mit
allen Informationen wie Layer, Time, Used Filament, usw. 
Sollte das Modell zu groß oder zu hoch sein werden dir unten Rechts rote Infoblasen
mit Warnungen angezeigt.

1. Remote Print starten
Drücke auf Start Print
⚙️ Aktiviere Optionen wie:

Bed Leveling

Resonance Compensation

AI Detection  (nur bei Kamera verfügbar)
Time-lapse  (nur bei Kamera verfügbar)
Flow Calibration

Für erweiterte Einstellungen, mehrfarbige Drucke und optimierte Profile gibt es später
eigene Kapitel.

Informationen zur Farbverwaltung eines 3D Objekts findest du im Kapitel Mehrfarbdruck

Erklärung zu verschiedenen Warnings findest du im Kapitel Troubleshooting



Wenn du mit dem Ergebnis zufrieden bist und dein Drucker sauber gearbeitet hat, kannst du
dein Modell inklusive aller Einstellungen speichern:
File > Save Project As (.3mf)
So bleibt alles erhalten – Position, Einstellungen, Materialprofil, Farben.
Beim nächsten Mal einfach wieder öffnen und direkt drucken: Ready to use!



Optionen



Optionen

Das Einfügen von erhabenem Text (Embossed) ist eine tolle Möglichkeit, deine Modelle zu
personalisieren – z. B. für Namensgravuren, kleine Botschaften oder Designakzente. In Anycubic
Slicer Next geht das intuitiv und ohne externe CAD-Software. Hier zeigen wir dir Schritt für Schritt,
wie du Text auf deinem 3D-Modell anbringst.

Lade dein .stl -Modell in den Prepare-Tab und positioniere es auf dem virtuellen Druckbett. Du
kannst es drehen, skalieren und zentrieren, je nachdem wo der Text später erscheinen soll.

Option Embossed Text
? Embossed Text

? 1. Objekt vorbereiten

https://angycubic.de/uploads/images/gallery/2025-06/cdH5LBiL18SMaTFx-screenshot-from-2025-06-29-12-43-22.png


Klicke oben auf das T-Symbol in der Werkzeugleiste – damit öffnest du das Text-Werkzeug. Es
erscheint ein Eingabefeld auf der rechten Seite sowie ein Platzhaltertext im Modell.

Gib deinen gewünschten Text ein (z. B. Marcel). Danach kannst du Schriftart, Größe und Tiefe
festlegen:

Font: z. B. Segoe UI oder Arial
Height: z. B. 7.0 mm (Höhe des Texts)
Depth: z. B. 1.0 mm (wie hoch oder tief der Text ragen/sinken soll)

?? 2. Text hinzufügen

? 3. Text eingeben & erste Einstellungen

https://angycubic.de/uploads/images/gallery/2025-06/1jUpNgq4pq0r5Qub-screenshot-from-2025-06-29-12-43-49.png


Wenn du „Advanced“ aktivierst, erhältst du weitere Einstellmöglichkeiten für die präzise
Gestaltung deines Textes. Diese Optionen helfen dir dabei, den Text z. B. auf Rundungen
anzupassen oder den Abstand zu verändern.

Option Bedeutung

Char-gap Abstand zwischen einzelnen Buchstaben (z. B. 0.5 mm)

Line-gap Abstand zwischen mehreren Textzeilen

Boldness Stärke der Buchstabenlinie – je höher, desto fetter die
Schrift

Skew-ratio Kippung der Schrift, ähnlich wie kursiv

Slew-ratio Verzerrung entlang gekrümmter oder geneigter Flächen

From-surface Abstand des Textes zur Oberfläche – 0 mm bedeutet direkt
anliegend

?? 3b. Advanced-Optionen im Detail

https://angycubic.de/uploads/images/gallery/2025-06/LDqLMUxovxW8G9t8-screenshot-from-2025-06-29-12-45-22.png


Option Bedeutung

Rotation Drehung des Textes in Grad (z. B. 90° für senkrecht)

Aktiviere die Option „Use-surface“ – damit wird der Text an die Oberfläche des Objekts angepasst
(auch bei Rundungen). Mit „From-surface“ kannst du ihn leicht hervorheben oder einbetten.

Im unteren Bereich wählst du die Art des Textes:

Join = Text wird erhaben (Embossed) – also auf das Objekt „aufgesetzt“
Cut = Text wird eingeschnitten (Engraved) – ideal für Gravuren
Modifier = definiert eine Zone für spezielle Slicing-Parameter

Für erhabenen Text: Join

? 4. Text an Oberfläche ausrichten

? 5. Operation auswählen



Du kannst den Text mit dem Mausrad, gedrückter rechter Maustaste oder den Eingabefeldern
präzise ausrichten. Über „Rotation“ kannst du ihn beispielsweise um 90° drehen, damit er entlang
eines Stifts oder Rings verläuft.

Im Prepare-Tab kannst du jedem Objekt auf dem Druckbett eine eigene Farbe zuweisen. 

1. Wähle links im Bereich „Objects“ das Objekt aus, dessen Farbe du ändern möchtest.
2. Klicke auf das kleine farbige Quadrat rechts neben dem Objektnamen.
3. Ein Farbwähler erscheint – dort kannst du eine Farbe aus der Palette deines ACE

auswählen.
4. Die ausgewählte Farbe wird sofort auf das Objekt im Druckbett übertragen (visuelle

Darstellung).

?? 6. Position und Ausrichtung

? 6a. Objektfarbe im Prepare-Tab ändern

? So gehst du vor:

https://angycubic.de/uploads/images/gallery/2025-06/uu9QavuYVXNjx0YW-screenshot-from-2025-06-29-13-05-49.png


5. Optional: Wiederhole den Vorgang für weitere Objekte.

Klicke auf „Save Project“, dann auf „Slice Plate“. Überprüfe in der Layer-Vorschau, ob der Text
korrekt dargestellt ist – und speichere anschließend die .gcode -Datei wie gewohnt.

? 7. Speichern & Slicen



Optionen

Mit der Add-Option importierst du neue 3D-Modelle in die Arbeitsfläche des Anycubic Slicer Next.
So kannst du .stl , .3mf  oder .obj  Dateien direkt in dein Projekt laden.

Klicke in der oberen Leiste auf das Symbol mit dem Würfel und dem Plus
oder drücke Strg + I .

【 Image: Screenshot from 2025-06-29 – Add-Symbol in der Toolbar】

Im Dateiauswahlfenster wählst du eine .stl , .3mf  oder .obj  Datei von deinem Rechner aus und
klickst auf Öffnen.

【 Image: Screenshot from 2025-06-29 – Dateidialog】

Das Modell wird automatisch mittig auf dem virtuellen Druckbett platziert.

【 Image: Screenshot from 2025-06-29 – Modell auf dem Druckbett】

�� Tipp:
Du kannst mehrere Dateien gleichzeitig auswählen – sie werden automatisch nebeneinander
angeordnet.

Option Add (Strg+I)
?? Add in Anycubic Slicer Next

1. Modell auswählen

2. Datei öffnen

3. Modell positionieren



Optionen

Mit der Add Plate–Option fügst du deinem Projekt eine weitere Bauplatte hinzu. Besonders
nützlich, wenn du mehrere Druckplattformen oder modulare Aufbauten simulieren möchtest.

Klicke in der oberen Leiste auf das Symbol mit dem Quadrat und dem Plus
oder drücke Strg + P .

【 Image: Screenshot from 2025-06-29 – Add-Plate-Symbol in der Toolbar】

Im Dialogfenster legst du Größe, Position und Höhe der neuen Platte fest.
Passe die Werte nach deinem Druckbett und deinem Projektbedarf an.

【 Image: Screenshot from 2025-06-29 – Add-Plate-Dialog mit Parametern】

Bestätige mit OK.
Die neue Bauplatte erscheint im Vorschaufenster und wird in die Simulation übernommen.

【 Image: Screenshot from 2025-06-29 – Neue Platte auf dem Druckbett】

�� Tipp:
Du kannst mehrere Platten hintereinander hinzufügen und so komplexe Multi-Plate-Setups testen.

add-plate: Funktion zum Hinzufügen einer weiteren Bauplatte.

strg-p: Tastenkombination für die Add Plate–Option.

Option Add plate
?? Add Plate in Anycubic Slicer Next

1. Add Plate wählen

2. Parameter festlegen

3. Platte platzieren





Optionen

Mit der Auto Orient-Option richtest du deine Modelle automatisch flach auf der Bauplatte aus –
ideal für unregelmäßige oder schiefe Objekte.

Klicke in der oberen Leiste auf das Symbol mit den sich drehenden Pfeilen.

【 Image: Screenshot from 2025-06-29 – Auto-Orient-Symbol in der Toolbar】

Anycubic Slicer Next ermittelt die optimale Position und legt alle Modelle flach auf die Bauplatte.

【 Image: Screenshot from 2025-06-29 – Modelle nach Auto Orient auf der Bauplatte】

Wechsle in die Vorschau-Ansicht, um sicherzustellen, dass alle Objekte korrekt ausgerichtet sind.

【 Image: Screenshot from 2025-06-29 – Vorschau mit ausgerichteten Modellen】

�� Tipp:
Für feine Anpassungen nutze die manuellen Dreh- und Verschiebungswerkzeuge im Prepare-Tab.

Option Auto Orient
? Auto Orient in Anycubic Slicer Next

1. Auto Orient wählen

2. Objekte ausrichten

3. Ausrichtung prüfen



3mf: Modernes 3D-Dateiformat, das zusätzliche Druckinformationen enthalten kann.

3mf-Dateien: 3D-Dateiformat, das zusätzliche Druckinformationen enthalten kann.

Acceleration: Beschleunigungswert eines Druckers – beeinflusst, wie schnell Bewegungen starten
oder enden.

ACE: Anycubic Color Engine – Modul für Farb- und Materialsteuerung beim Mehrfarbdruck.

Add: Werkzeug zum Einfügen von 3D-Modellen in die Arbeitsfläche.

add-plate: Funktion zum Hinzufügen einer weiteren Bauplatte.

AMS: Automatic Material System – automatischer Materialwechsler zur Nutzung mehrerer
Filamente.

auto-orient: Funktion zur automatischen Ausrichtung von Modellen auf der Bauplatte.

Bed Leveling: Kalibrierung des Heizbetts, um eine gleichmäßige erste Schicht zu gewährleisten.

Boldness: Stärke der Buchstabenlinie – je höher, desto fetter die Schrift.

Brim: Flacher Rahmen rund um ein Modell zur besseren Haftung auf dem Druckbett.

Build Plate Adhesion: Methoden zur Haftung auf dem Druckbett – z. B. Brim, Raft oder Skirt.

Char-gap: Abstand zwischen einzelnen Buchstaben.

Concentric: Infill folgt der äußeren Form in Kreisen – ästhetisch, aber strukturell schwächer.

Cooling: Kühlung der gedruckten Schichten – beeinflusst Detailgenauigkeit und Haftung.

Cooling: Steuerung der Lüftergeschwindigkeit – wichtig für kleine Details und Brücken.

Cross: Einfaches Kreuzmuster – minimalistisch, weniger stabil.

Cross-3D: Dreidimensionales Kreuzgitter – deutlich robuster als die flache Version.

Cubic: Würfelförmige Struktur, die Festigkeit in alle Richtungen bietet – ideal für mechanische Teile.

Glossar



Cubic-Subdivision: Wie Cubic, aber mit höherer Dichte nahe der Außenwände – spart Material im
Inneren.

Drop-Model: Lässt ein Objekt automatisch auf ein anderes Modell fallen – nützlich beim
Positionieren.

Embossed: Erhabener Text, der aus dem Objekt herausragt.

Engraved: Eingravierter Text, der in das Modell hineingeschnitten wird.

Flow: Menge an extrudiertem Material pro Zeiteinheit – wichtig für Genauigkeit und Stabilität.

Flow Calibration: Automatische Kalibrierung des Materialflusses zur Verbesserung der
Druckqualität.

From-surface: Abstand des Textes zur Oberfläche – 0 mm bedeutet direkt anliegend.

Fuzzy-Skin: Fügt absichtlich Unebenheiten hinzu – erzeugt eine raue Textur für haptische oder
visuelle Effekte.

Ghosting: Sichtbare Nachschwingungen oder Wellenmuster an den Außenwänden eines Drucks,
verursacht durch mechanische Vibrationen bei schnellen Bewegungen.

G-Code: Maschinensprache für 3D-Drucker – enthält alle Anweisungen für Bewegungen,
Temperatur usw.

Grid: Ein quadratisches Infill-Muster mit rechtwinkligen Linien, das schnell druckbar ist und eine
gute Stabilität bietet.

Grid Support: Stützstruktur mit regelmäßigem Raster – stabil und leicht zu entfernen.

Gyroid: Dreidimensionales, organisches Muster – sehr effizient für Festigkeit bei geringem Gewicht.

Import: Funktion zum Laden eines 3D-Modells in den Slicer aus einem Verzeichnis oder
Dateimanager.

Infill-Density: Prozentualer Anteil des Innenmaterials – beeinflusst Gewicht, Stabilität und Druckzeit.

Infill-Line-Distance: Abstand zwischen den Infill-Linien – bestimmt die Dichte indirekt.

Infill-Overlap: Überlappung zwischen Infill und Außenwand – erhöht die Verbindung und Stabilität.



Input Shaping: Technik zur Reduzierung von Vibrationen und Wellenbildung bei schnellen
Bewegungen.

Jerk: Geschwindigkeitssprung, mit dem Bewegungen einsetzen – wirkt sich auf Druckqualität aus.

Layer: Einzelne horizontale Schicht eines 3D-Drucks – bestimmt die Detailauflösung.

Layer-Height: Dicke einer einzelnen Schicht – bestimmt Detailgrad und Druckdauer.

Line-gap: Abstand zwischen mehreren Textzeilen.

Lines Rectilinear: Gerade, parallele Linien, die sich pro Layer abwechseln – simpel und effizient.

Modifier: Slicer-Modus, der eine Zone für besondere Druckeinstellungen definiert.

Objects: Bereich im Slicer, in dem einzelnen Objekten Farben oder Extruder zugewiesen werden.

Octet: Dreidimensionales Gitter aus Dreiecken – sehr stabil bei wenig Materialeinsatz.

Organic Support: Organisch geformte Stützstruktur, die wenig Material verbraucht und gut
entfernbar ist.

Preview: Vorschau auf das geslicte Modell mit Informationen wie Druckzeit, Schichten und
Filamentverbrauch.

Process: Konfigurationsbereich im Slicer für Druckabläufe – inklusive Objektverwaltung und
Farbeinstellungen.

Raft: Mehrschichtige Unterlage unter dem Modell, verbessert Haftung auf schwierigen Oberflächen.

Remote Print: Funktion zum Starten des Druckvorgangs direkt vom Slicer aus per Wi-Fi.

Resonance Compensation: Funktion zur Minimierung von Vibrationen und Ghosting beim Druck.

Retraction: Rückzug des Filaments während Leerfahrten, um Fäden und Tropfen zu vermeiden.

Retraction: Zurückziehen des Filaments beim Reisen – verhindert Stringing.

Rotation: Drehung des Textes in Grad.

SD-Karte: Datenträger zur Übertragung von G-Code-Dateien an den Drucker.

Shaper Tools: Werkzeuge zur Feinsteuerung von Input Shaping und Bewegungsglättung.



Skew-ratio: Kippung der Schrift, ähnlich wie kursiv.

Skin: Geschlossene obere und untere Flächen – bestimmen das sichtbare Finish.

Slew-ratio: Verzerrung entlang gekrümmter oder geneigter Flächen.

Slicer: Software zur Umwandlung eines 3D-Modells in druckbare Schichten – erzeugt G-Code für
den Drucker.

Skirt: Randlinie um das Modell – verbessert Filamentfluss und zeigt Position des Drucks an.

Slice Plate: Befehl im Slicer, um das aktuelle Modell in Layer zu zerlegen und vorzubereiten.

Speed: Druckgeschwindigkeit – beeinflusst Präzision, Stabilität und Dauer des Drucks.

STL: Standard-Dateiformat für 3D-Modelle ohne Slicing-Parameter – empfohlen für den ersten
Testdruck.

Strg-I: Tastenkombination für die Add-Option.

strg-p: Tastenkombination für die Add Plate–Option.

Support: Allgemeiner Begriff für alle Stützstrukturen, die beim Druck überhängender Teile helfen.

Support-Structure: Temporäre Strukturen für Überhänge – werden nach dem Druck entfernt.

Support-Style: Art des Supports – z. B. Tree, Grid, Organic; beeinflusst Druckzeit und Entfernung.

Time: Geschätzte Druckzeit für das Modell, basierend auf den aktuellen Slice-Einstellungen.

Time-lapse: Zeitraffer-Aufnahmen vom Druckvorgang – erfordert Kameraunterstützung.

Top-Surface: Oberste sichtbare Schicht – beeinflusst die finale Oberflächenqualität.

Tree-Infill: Verzweigte, baumartige Struktur – meist für Stützstrukturen verwendet.

Tree Support: Baumartig verzweigte Stützstruktur – verbraucht wenig Material und ist leicht zu
entfernen.

Tree-Support-Tip-Diameter: Durchmesser der Kontaktspitze beim Tree Support – beeinflusst
Präzision und Haftung.

Troubleshooting: Kapitel mit Lösungsvorschlägen bei Warnungen oder fehlerhaften
Druckergebnissen.



USB: Alternative zum SD-Speicher für die Übertragung von Druckdaten.

Used Filament: Menge an Filament, die für den Druck benötigt wird.

Wall: Außenwand(en) des Drucks – wichtig für Festigkeit und Optik.

Warnings: Hinweise auf mögliche Probleme wie zu großes Modell, fehlender Kontakt oder
Überhänge.

Wi-Fi: Drahtlose Verbindung zum Drucker – Voraussetzung für Remote Print und Kamera-
Funktionen.

Z-Hop: Anheben der Düse beim Bewegen – verhindert Kratzer und Kollisionen.

Zigzag: Wellenartiges Muster – schnell, aber weniger stabil; in manchen Versionen nicht verfügbar.



�� [Kurze Einleitung in 1–2 Sätzen]

Bildbeschreibung

Kurzer Absatz mit Erklärung zum Vorbereitungsschritt.

Bildbeschreibung

Text mit Beschreibung der Funktion.
Wenn nötig, Zwischenhinweise wie:

Was genau bewirkt diese Einstellung?
Wann sollte man sie verwenden?

Einstellung Bedeutung Empfehlung

Example A Erklärt A ✔️ Ja

Example B Erklärt B ❌  Nein

Tipp: Je nach Bedarf können Tabellen oder Listen eingesetzt werden.

Kurze Praxisbeispiele:

Objekt X braucht diese Funktion

Standardvorlage: Anycubic
Slicer Next Seite

? 1. Objekt vorbereiten

? 2. Funktion aktivieren

?? 3. Erweiterte Optionen im Detail

? 4. Anwendung & Hinweise



Objekt Y besser ohne

Ggf. Screenshot oder Referenz aus Druckvorschau.

Next → Glossar anzeigen

? 5. Glossarbegriffe

? Glossarformat (für Glossarseite)
Slicer: Software zur Umwandlung eines 3D-Modells in G-Code.

auto-orient: Funktion zur automatischen Optimierung der Druckausrichtung.

brim: Eine flache Umrandung am ersten Layer zur besseren Haftung.

https://angycubic.de/../page/glossar


Diese Einstellungen steuern, wie die Tree Supports wachsen, sich verzweigen und an deinem
Modell anliegen.

Definition: Ab welchem Überhangwinkel Support erzeugt wird
Typischer Wert: 45°
Kleiner = mehr Support, z. B. bei 30° auch bei leichten Überhängen
Größer = weniger Support, z. B. bei 60° nur bei extremen Überhängen
�� Empfehlung für Figuren & Details: 45–50°

Definition: Maximaler Winkel zwischen zwei Ästen eines Supportbaums
Typischer Wert: 35–40°
Kleiner = steiler, stabiler Support
Größer = flacher, aber instabiler
�� Empfehlung für stabile Stützen ohne Wackler: 35°

Branch Diameter: 2.0 mm
Branch Distance: 1.5 mm
Branch Density: 80–100 %  für hohe Detailtreue
Z-Distance (Z-Kontaktabstand): 0.2 mm  (für einfache Entfernung)

Reiter "Supports"
? Support: Tree Branch Settings (Anycubic
Slicer Next)

? Threshold Angle (Support-Winkel)

? Branch Angle (Verzweigungswinkel)

? Weitere empfohlene Einstellungen (für saubere, ablösbare
Supports):

✨  Tipp: Für kleine Details wie Finger, Antennen oder Lotusfüße lieber mehr
kleine Verzweigungen als wenige dicke Säulen.“



To remove user presets in Anycubic Slicer Next, you need to locate the configuration files and
delete the specific preset files. First, find the configuration folder by going to Help > Open
Configuration Folder. Then, navigate to the "user" folder and then to your specific profile folder
(e.g., a folder with a number). Inside, you'll find folders for filament, machine, and process. Locate
and delete the JSON files corresponding to the preset you want to remove. 

User Preset


